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Introduction to Resource Configuration

Before running any application on servers in a NetWare Cluster Services 
cluster, the application must be installed and configured properly to take 
advantage of shared storage and to achieve high availability. This document 
provides information to help you set up and configure some of the applications 
commonly used in a NetWare 5 environment. See the NetWare Cluster 
Services Overview and Installation documentation for cluster installation and 
configuration, and your application documentation for specific application 
installation and setup instructions.
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Configuring GroupWise with NetWare 
Cluster Services

GroupWise Installation and Configuration

To get the full benefit of using GroupWise® with NetWare® Cluster 
ServicesTM, GroupWise must be installed and configured to work in a cluster 
environment. 

GroupWise Configuration Requirements

Before configuring NetWare Cluster Services to use GroupWise, GroupWise 
must be installed and configured properly. See the GroupWise documentation 
at http://www.novell.com/groupwise/administration/gw55/us/gwadmin.html 
(http://www.novell.com/groupwise/administration/gw55/us/gwadmin.html) 
for installation and setup instructions. In addition, ensure the following 
GroupWise configuration requirements are met:

� GroupWise must be configured in Client/Server mode. GroupWise will 
not failover or failback in a cluster environment without Client/Server 
mode.

� NetWare Cluster Services requires that all GroupWise post offices and 
domains be on shared volumes if GroupWise is to failover or failback. 
Cluster-enabling shared volumes is not recommended and not necessary 
for GroupWise to function with NetWare Cluster Services.
Configuring GroupWise with NetWare Cluster Services �
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� Since GroupWise agent software must be accessible from every server 
that will support the GroupWise post office and domain, you must 
generate startup files and install the GroupWise NLMs in the 
SYS:SYSTEM directory of each cluster server where GroupWise will 
run. Install and configure GroupWise on one server in your cluster. Be 
sure to create the post office, domain, and the software distribution 
directory on a shared volume and install Message Transfer Agents 
(MTAs) and Post Office Agents (POAs) on the same shared volume.

During the GroupWise installation you are given the option of installing 
the GroupWise agents on multiple servers. Use this option to install the 
GroupWise agents and create and configure the GroupWise startup files 
on each server in the cluster that will run GroupWise.

If you need to install the GroupWise agents on additional cluster servers 
after the initial installation, you should run INSTALL.EXE from the 
AGENTS directory at the root of the GroupWise product CD. This 
Installation program not only installs the GroupWise agents, but creates 
and configures GroupWise startup files on each server. 

� The GroupWise (MTA) and each (POA) require their own IP addresses. 
These IP addresses float with the resource when a failover or failback 
occurs and are not bound to a specific server in the cluster.

If you have trouble linking IP addresses to the MTA or a POA, check the 
GroupWise link definitions in NetWare Administrator by clicking Tools 
> GroupWise Utilities > Link Configuration. The links should be 
configured for TCP/IP, not UNC paths.

� Multiple post offices can share the same volume, but all POAs for those 
post offices must be launched from the same resource, even if they use 
different protected address spaces.

Review GroupWise Startup Files

In many cases, GroupWise is started by running GRPWISE.NCF on the server 
where GroupWise is to be loaded. GRPWISE.NCF normally contains two 
lines.

LOAD GWMTA.NLM@<MTA Startup file>

LOAD GWPOA.NLM@<POA Startup file>
� Resource Configuration Guide
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For example, if the MTA startup file is named GWDOMAIN.MTA and the 
POA startup file is named GWPOST.POA, the two lines read as follows:

LOAD GWMTA.NLM@GWDOMAIN.MTA

LOAD GWPOA.NLM@GWPOST.POA

Both the MTA and POA startup file have one required parameter:

/HOME<Server Name>/<Domain Directory>

In the MTA startup file, this parameter points the MTA to its domain. In the 
POA startup file, this parameter points the POA to its post office directory. For 
both the MTA and POA startup file, the server name must be specific to each 
server, so each server in the cluster will have slightly different startup files. 
The STARTUP.NCF file is automatically customized for each cluster server 
when you install the GroupWise agents. After installation, you should review 
the STARTUP.NCF file on each server to ensure it is correct.

Optional GroupWise Configuration

Once the above GroupWise configuration requirements have been met, 
additional configuration might be necessary depending on how you will use 
GroupWise with NetWare Cluster Services. Optional configurations to 
consider are: 

� If you create multiple post offices on one server and configure them as 
separate resources for failover control, each POA must be loaded in 
protected memory space and each POA must have its own shared volume. 
If all POAs are loaded in kernel memory space, the first post office to 
unload will shutdown all other post offices. Ensure you have enough 
memory on each cluster server to accommodate the maximum number of 
POAs that could failover to that server.

� You can associate the Message Transfer Agent (MTA) with a post office 
or configure it as a separate resource. Associating the MTA with a post 
office is the recommended configuration. Only one MTA runs on each 
domain.
Configuring GroupWise with NetWare Cluster Services �
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Configure GroupWise for Protected Memory

Configuring GroupWise to use protected memory can give you a higher level 
of availability. It allows GroupWise to restart automatically on the same node 
after a failure instead of failing over to another node in the cluster. Using 
protected memory is required if you want to create multiple post offices on one 
server and configure them as separate resources for failover control. It is also 
recommended if you intend to use one shared volume for each GroupWise 
post office.

To run GroupWise in protected memory, change the line that loads 
GWPOA.NLM in the GRPWISE.NCF file to 

LOAD ADDRESS SPACE=<NAME>RESTART GWPOA.NLM@<POA Startup 
file>

Replace <NAME> with the name you want to give the protected memory 
space and <POA Startup file> with the name of the POA Startup file.

The RESTART flag is optional. For more information on load commands, 
type HELP LOAD at the console prompt of any NetWare 5 server.

Configure The GroupWise Gateway

If you want the GroupWise gateway to be highly available, you must 
configure it specifically for NetWare Cluster Services. To configure the 
GroupWise gateway for high-availability: 

� Ensure the GroupWise gateway is installed according to the instructions 
in the GroupWise documentation.

� Copy the following files from the SYS:SYSTEM directory of the first 
GroupWise server in the cluster to the SYS:SYSTEM directory of all 
servers in the cluster where GroupWise is installed.

GWIA.NLM
GWIA.NCF
GWIA.FIL
GWENN15.NLM
GWIA.CFG

Copying these files may not be necessary if they already exist on the other 
GroupWise servers in the cluster.
�� Resource Configuration Guide
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�  Edit the GWIA.CFG file on all GroupWise servers in the cluster and find 
the following two lines:

/home-\\node1\shared_NSS_vol\domain\wpgate\GWIA

/dhome-\\node1\shared_NSS_vol\domain\wpgate\GWIA

Replace node1 with the name of the server where the GWIA.CFG file 
resides. Since each GWIA.CFG file resides on a different server, the 
server name will vary depending on which GWIA.CFG file is being 
edited. Replace shared_NSS_vol with the name of the GroupWise shared 
disk volume.

NetWare Cluster Services Configuration and Setup

Once GroupWise is installed and configured to run in a cluster environment, 
you must create and configure a GroupWise resource in NetWare Cluster 
Services. This includes configuring GroupWise load and unload scripts; 
setting GroupWise Start, Failover, and Failback modes; and assigning the 
GroupWise resource to specific servers in your cluster.

Creating a GroupWise Cluster Resource

NetWare Cluster Services includes a GroupWise resource template, which 
greatly simplifies the process for creating a GroupWise cluster resource. Much 
of the GroupWise cluster resource configuration is perfomed automatically by 
the GroupWise resource template.

� In ConsoleOneTM, browse and select the Cluster object.

� Click File > New > Cluster > Cluster Resource.

� Enter a name for the GroupWise cluster resource.

� Enter the GroupWise template name in the Inherit From Template field, 
or browse and select it from the list.

� Click Create.

The GroupWise resource template configures the GroupWise resource by 
automatically creating GroupWise load and unload scripts; setting Start, 
Failover and Failback modes and assigning GroupWise as a resource to 
all nodes in the cluster. 

After creating a GroupWise resource, you should view or edit the GroupWise 
resource to ensure it is configured correctly for your specific needs.
Configuring GroupWise with NetWare Cluster Services ��

Resource Configuration Guide
Place Part Number Here

February 5, 2001



Manual Rev 99a28 9 June 00
Configuring GroupWise Load and Unload Scripts

The GroupWise resource template automatically creates a load and unload 
script to start and stop GroupWise on servers in your cluster. The load and 
unload scripts both contain IP address and volume-specific commands that 
you must customize for your specific GroupWise configuration.

To view or edit the GroupWise load and unload scripts:

� In ConsoleOne, right click the GroupWise Resource object and select 
Properties.

� Click the Load or Unload Script tab on the property page.

� Edit the IP address and volume-specific commands in both scripts.

For example, you will need to edit the following three lines in the load 
script: 

ADD SECONDARY IPADDRESS A.B.C.D

NSS /ACTIVATE=volume

MOUNT volume

Replace A.B.C.D with the desired IP address and volume with the name 
of the GroupWise volume on the shared disk system. 

Review the other lines in both scripts and edit them as necessary.

If you configure GroupWise to run in protected memory, ensure the 
commands in the unload script reference the same protected address 
space as those in the load script.

Setting GroupWise Start, Failover, and Failback Modes

The GroupWise resource template sets the GroupWise resource Start Mode 
and Failover Mode to AUTO, and the Failback Mode to DISABLE. With the 
GroupWise resource Start Mode set to AUTO, GroupWise will automatically 
start on a server when the cluster is first brought up. If the GroupWise Start 
Mode is set to MANUAL, you can manually start GroupWise on a server 
when you want, instead of having it automatically start when servers in the 
cluster are brought up. 
�� Resource Configuration Guide
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With the GroupWise Failover Mode set to AUTO, GroupWise will 
automatically start on the next server in the Assigned Nodes list in the event 
of a hardware or software failure. If the GroupWise Failover Mode is set to 
MANUAL, you can intervene after a failure occurs and before GroupWise is 
moved to another node.

With the GroupWise Failback Mode set to DISABLE, Groupwise will not 
failback to its most preferred node when the most preferred node rejoins the 
cluster. If the Groupwise Failback Mode is set to AUTO, GroupWise will 
automatically failback to its most preferred node when the most preferred 
node rejoins the cluster. Set the GroupWise Failback Mode to MANUAL to 
prevent GroupWise from moving back to its preferred node when that node is 
brought back online, until you are ready to allow it to happen. 

To view or change GroupWise Start, Failover, and Failback modes:

� In ConsoleOne, right click the GroupWise resource object and select 
Properties.

� Click the Policies tab on the property page.

� View or change the Start, Failover or Failback modes for GroupWise.

View or Edit GroupWise Resource Server Assignments

The GroupWise resource template automatically assigns the GroupWise 
resource to all nodes in the cluster. The order of assignment is the order the 
nodes appear in the resource list. To view or edit GroupWise resource node 
assignments or change the server failover order:

� In ConsoleOne, right click the GroupWise resource object and select 
Properties.

� Click the Nodes tab on the property page.

� View the current GroupWise resource server assignments, and if 
necessary, click the right or left arrow button to assign or unassign servers 
to the GroupWise resource.

You can click the up or down arrow button to change the failover order of 
the servers assigned to GroupWise.

Additional NetWare Cluster Services Configuration Information

For additional information on setting up and configuring NetWare Cluster 
Services, go to NetWare Cluster Services.
Configuring GroupWise with NetWare Cluster Services �	
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Configuring Novell Distributed Print 
Services with NetWare Cluster 
Services

Benefits of High Availability Printing

Running Novell® Distributed Print ServicesTM (NDPS®) on a NetWare cluster 
provides the following benefits:

� Centralized management

� By configuring the Print Management Database to reside on a shared 
disk cluster volume, you no longer need to replicate information to 
achieve high availability.

� The need to back up and restore the NDPS configuration object to 
NDS is eliminated.

� The cluster console GUI allows you to monitor and control the 
location of cluster volumes with the Broker and Print Manager 
services using them from a single management workstation.

� Because cluster volumes are tightly consistent and highly available, 
distributed print management tasks are simplified.

� Automatic restart of print services

� If a server fails, the cluster volume containing the Print Management 
Database and spool area automatically remount on a surviving server 
in the cluster. The Broker and Print Manager NLMs will also 
automatically restart without user intervention.
Configuring Novell Distributed Print Services with NetWare Cluster Services ��
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� On restart, the Broker and Print Manager will discover the Print 
Management Database on a cluster volume mounted on their server. 
Because the cluster volume is the same regardless of which server it 
is mounted on, no print related information is lost or out of date.

Install NDPS

NDPS should already be installed on servers that will be part of your cluster 
before you install NetWare Cluster Services. If you want to install NDPS after 
installing NetWare Cluster Services, perform the following steps:

� Install NDPS or NetWare Enterprise Print Services on each of the cluster 
servers that will run NDPS.

� Install the latest available NetWare 5 Support Pack on each of the servers 
where you installed NDPS or NetWare Enterprise Print Services.

If you are using NetWare 5 Support Pack 4 or later, no additional 
configuration is necessary. If you are not, continue with Step 3.

� Copy BROKER.NLM from the \NI\SYSTEM directory on the NetWare 
Cluster Services CD to the SYS:\SYSTEM directory of each server that 
will run NDPS.

� Copy NDPSM.NLM from the \NI\TEMP\NDPS directory (or from the 
\NI\TEMP\NEPS directory if you are using NetWare Enterprise Print 
Services) on the NetWare Cluster Services CD to the SYS:\SYSTEM 
directory of each server that will run NDPS.

Create and Configure NDPS Broker and Print Manager

Before running NDPS in a NetWare cluster environment, you must create 
NDPS Print Brokers and Managers and create and configure NetWare Cluster 
volumes to work with NDPS.

� Create an NSS cluster volume.

�� From any server in the cluster, use NWConfig to create an NSS 
volume dedicated to printing.

�� Mount the volume on the server used to create it.
�� Resource Configuration Guide
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�� Ensure the volume is visible to the NDPS NWAdmin snap-ins by 
running NWConfig and selecting Directory Options > Upgrade 
Mounted Volumes into the Directory.

Upgrade only the volume you created for printing.

�	 Deactivate the NSS volume by typing

NSS/DEACTIVATE=<VOLUME>

This will also dismount the volume. Replace <VOLUME> with the 
name of the dedicated print volume. 

� Cluster-enable the dedicated print volume.

�� Choose a dedicated IP address for the dedicated print volume.

�� Using ConsoleOneTM, select File > New Cluster Volume and browse 
and select the dedicated print volume.

�� Enter the IP address you chose for the print volume.

�	 Change the view to Cluster State by clicking View > Cluster State 
and then click the print volume resource and the Online button.

This will mount the volume as a Cluster Resource on one of the 
servers in the cluster (determined by the Cluster Volume Resource’s 
assigned nodes property).

� Prepare the print volume for a print broker.

�� Using Windows* Explorer, browse and select the Print volume in the 
NDS tree.

This creates a client connection to the server currently hosting the 
volume.

�� Copy the NDPS\RESDIR directory structure from the SYS: volume 
of a server containing the resource files to the root directory of the 
Print volume.

Ensure \NDPS is the top level directory at the root of the Print 
volume.

The resource files are not always installed on all servers. They are 
however by default installed on the server you used to install NDPS 
into the tree.

Ensure the resource files exist in the SYS:\NDPS\RESDIR directory 
before copying the directory structure.
Configuring Novell Distributed Print Services with NetWare Cluster Services ��
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� Create an NDPS Broker.

�� In NetWare Administrator, click Object > Create New Object and 
select NDPS Broker.

You will be asked for an RMS Volume.

�� Select the Print volume object (CLUSTER_VOLUME).

CLUSTER is the name of your cluster and VOLUME is the name of 
the dedicated Print volume.

Ensure you have a connection to the virtual server before completing 
this step, or the creation will fail. If you don’t have a connection use 
Windows Explorer and browse to the volume to create one.

� Create an NDPS Print Manager.

�� In NetWare Administrator, click Object > Create New Object and 
select NDPS Manager.

You will be asked for a Resident Server.

�� Select the Print Volume’s corresponding Virtual Server object 
(CLUSTER_VOLUME_SERVER).

You will be asked for a Database Volume.

�� Select the Print Volume object.

Ensure you have a connection to the virtual server before completing 
this step, or the creation will fail. If you don’t have a connection use 
Windows Explorer and browse to the volume to create one.

Configure the NDPS Cluster Volume Resource

Once you have created and cluster-enabled an NDPS volume, you must 
configure load and unload scripts, set Start, Failover and Failback modes, and 
assign the NDPS volume to specific servers in your cluster. 

Configuring the NDPS Volume Load and Unload Scripts

Load and unload scripts are required by NetWare Cluster Services to start and 
stop NDPS and mount the NDPS volume on servers in the cluster.

Before adding commands to the NDPS cluster volume’s load and unload 
scripts, you should test to ensure the NDPS Broker and Print Manager will run 
with the cluster volume.
�� Resource Configuration Guide
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To configure the NDPS volume load and unload scripts:

� In ConsoleOne, right-click the NDPS Cluster Volume Object and select 
Properties.

� Click the Load Script tab on the property page and add a line to mount the 
NDPS volume on a server. In addition, add the following lines to the end 
of the load script.

LOAD BROKER MY_BROKER /ALLOWDUP

LOAD NDPSM MY_PRINT_MANAGER /DBVOLUME=NOCHECK

Replace MY_BROKER with the name of the NDPS Print Broker and 
replace MY_PRINT_MANAGER with the name of the NDPS Print 
Manager.

The /ALLOWDUP command line switch instructs the NDPS Broker to 
avoid its check for duplicate Brokers at start-up. Because NetWare 
Cluster Services ensures only one Broker NLM runs and references the 
same NDS Broker configuration object at a time, this option allows the 
Broker to start faster without human intervention by avoiding a 
communication timeout based check for an existing Broker.

The /DBVOLUME=NOCHECK command line switch instructs the 
NDPS Print Manager to avoid checking whether its database volume is 
local or remote. This switch allows the Print Manager to simply open the 
cluster volume identified in its NDS configuration object.

� Click the Unload Script tab on the property page and add a line to 
dismount the NDPS volume from a server. In addition, add the following 
lines to the beginning of the unload script.

UNLOAD NDPSM

UNLOAD BROKER

If the Broker and Print Manager are set up to each use different cluster 
volumes, then add only the appropriate Load and Unload lines specific to each 
volume.
Configuring Novell Distributed Print Services with NetWare Cluster Services ��
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Setting NDPS Start, Failover, and Failback modes

NetWare Cluster Services by default sets the NDPS Cluster volume Start 
Mode and Failover Mode to AUTO, and the Failback Mode to DISABLE. If 
the NDPS volume Start Mode is set to AUTO, NDPS automatically starts on 
a server when the cluster is first brought up. If the NDPS volume Start Mode 
is set to MANUAL, you can manually start NDPS on a server when you want, 
instead of having it automatically start when servers in the cluster are brought 
up.

If the NDPS volume Failover Mode is set to AUTO, NDPS automatically 
starts on the next server in the Assigned Nodes list in the event of a hardware 
or software failure. If the NDPS volume Failover Mode is set to MANUAL, 
you can intervene after a failure occurs and before NDPS is moved to another 
node.

If the NDPS volume Failback Mode is set to DISABLE, NDPS will not 
failback to its most preferred node when the most preferred node rejoins the 
cluster. If the NDPS volume Failback Mode is set to AUTO, NDPS will 
automatically failback to its most preferred node when the most preferred 
node rejoins the cluster. Set the NDPS volume Failback Mode to MANUAL 
to prevent NDPS from moving back to its preferred node when that node is 
brought back online, until you are ready to allow it to happen. 

To view or change NDPS volume Start, Failover, and Failback modes:

� In ConsoleOne, right-click the NDPS Volume Resource object and select 
Properties.

� Click the Policies tab on the property page.

� View or change the Start, Failover or Failback modes for the NDPS 
volume.

Setting NDPS Volume Server Assignments

NetWare Cluster Services by default assigns the NDPS volume resource to all 
nodes in the cluster. The order of assignment is the order the nodes appear in 
the resource list. To view or edit NDPS volume resource node assignments or 
change the server failover order:

� In ConsoleOne, right click the NDPS volume resource object and select 
Properties.

� Click the Nodes tab on the property page.
�� Resource Configuration Guide
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� View the current NDPS volume resource server assignments, and if 
necessary, click the right or left arrow button to assign or unassign servers 
to the NDPS volume resource.

You can click the up or down arrow button to change the failover order of 
the servers assigned to the NDPS volume.

In order for the Broker to load and enable the Resource Management Service 
properly you must ensure the IP address of the NDPS cluster volume is added 
to the \ETC\HOSTS file of each server in the cluster that will host the NDPS 
volume.

Use a text editor to open the HOSTS file and if necessary add the IP address 
you assigned to the NDPS volume resource when you cluster-enabled it. For 
example, if the NDPS cluster volume is named 
CLUSTER_NDPSVOL_SERVER and the IP address for that cluster volume 
is 137.65.119.70, you would add the following line:

137.65.119.70 CLUSTER_NDPSVOL_SERVER
Configuring Novell Distributed Print Services with NetWare Cluster Services ��
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Configuring Oracle 8i with NetWare 
Cluster Services

Oracle Installation and Configuration

Before running Oracle* with NetWare® Cluster ServicesTM, Oracle must be 
installed and configured properly. See the Oracle documentation for specific 
installation and setup instructions. Oracle must be installed on its own volume 
on the shared disk system to function with NetWare Cluster Services. Prior to 
installing Oracle:

� Create a dedicated NSS volume on the shared disk system for Oracle.

Cluster-enabling shared volumes is not recommended and is not 
necessary for Oracle to function with NetWare Cluster Services.

� Mount the dedicated NSS volume for Oracle on the server you will install 
Oracle from.

� Choose a dedicated IP address for Oracle.

The dedicated IP address is assigned to Oracle and will move with Oracle 
to specified servers in the cluster during failover and failback.

� Add the dedicated IP address on the server you will install Oracle from.

For example, if the dedicated IP address is 123.45.67.20, type the 
following at the server console prompt:

add secondary ipaddress 123.45.67.20
Configuring Oracle 8i with NetWare Cluster Services �	
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To install Oracle:

� Mount the Oracle CD on the server.

�� Insert the Oracle CD and type cdrom at the console prompt.

�� Record the volume name of the Oracle product CD, because you will 
be required to supply it when entering the path to the Oracle 
installation program.

� Install Oracle from the product CD.

If the X-Server GUI Console is not currently running, start it by typing 
LOAD STARTX.NLM at the console command line. Then go back to the 
console command line and type the command (including the path) to start 
the installation program. For example, if the Oracle CD volume name is 
O8INW, specify the path as:

O8INW:\ORASETUP

Make sure you select the Oracle volume on the shared disk system as the 
location to install.

The IP address you assign to the Oracle server will move with Oracle 
from server to server during failover and failback.

During the installation, record the password you assign to the 
administrator.

� After installation is complete, edit 
VOLUME:OraHome1\NLM\startdb.sql and find the CONNECT 
INTERNAL/PASSWORD line. Replace PASSWORD with the password 
you assigned the administrator during the installation. Also edit 
VOLUME:OraHome1\NLM\stopdb.sql and add the same password to 
the CONNECT INTERNAL/PASSWORD line in that file.

NetWare Cluster Services Configuration and Setup

Once Oracle is installed on the shared disk system, you must create and 
configure an Oracle resource in NetWare Cluster Services. This includes 
configuring Oracle load and unload scripts; setting Oracle Failover and 
Failback modes; and assigning the Oracle resource to specific servers in your 
cluster.
�
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Creating an Oracle Cluster Resource

NetWare Cluster Services includes an Oracle resource template, which greatly 
simplifies the process for creating an Oracle cluster resource. Much of the 
Oracle cluster resource configuration is perfomed automatically by the Oracle 
resource template.

To create an Oracle cluster resource:

� In ConsoleOne, browse and select the Cluster object.

� Click File > New > Cluster > Cluster Resource.

� Enter a name for the Oracle cluster resource.

� Enter the Oracle template name in the Inherit From Template field, or 
browse and select it from the list.

� Click Create.

The Oracle resource template configures the Oracle resource by 
automatically creating Oracle load and unload scripts, setting failover and 
failback modes and assigning Oracle as a resource to all nodes in the 
cluster. 

After creating an Oracle resource, view or edit the Oracle resource to ensure 
it is configured correctly.

Edit Oracle Load and Unload Scripts

The Oracle resource template automatically creates a load and unload script to 
start and stop Oracle on servers in your cluster. The load and unload scripts 
both contain IP address and volume-specific commands that you must 
customize for your specific Oracle configuration.

To view or edit the Oracle load and unload scripts:

� In ConsoleOneTM, right click the Oracle Resource object and select 
Properties.

� Click the Load or Unload Script tab on the property page.

� Edit the IP address and volume-specific commands in both scripts.

For example, edit the following three lines in the load script: 

add secondary ipaddress A.B.C.D

nss /activate=VOLUME

search add VOLUME:orahome1\NLM
Configuring Oracle 8i with NetWare Cluster Services ��
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Replace A.B.C.D with the desired IP address, and replace VOLUME with 
the name of the Oracle volume on the shared disk system.

Review the other lines in both scripts and edit them as necessary.

Setting Oracle Start, Failover, and Failback Modes

The Oracle resource template sets the Oracle resource Start Mode and 
Failover Mode to AUTO, and the Failback Mode to DISABLE. 

If the Oracle resource Start Mode is set to AUTO, Oracle automatically loads 
on a designated server when the cluster is first brought up. If the Oracle Start 
Mode is set to MANUAL, you can manually start Oracle on a specific server 
when you want, instead of having it automatically start when servers in the 
cluster are brought up. 

If the Oracle Failover Mode is set to AUTO, Oracle automatically moves to 
the next server in the Assigned Nodes list in the event of a hardware or 
software failure. If the Oracle Failover Mode is set to Manual, you can 
intervene after a failure occurs and before Oracle is moved to another node.

If the Oracle Failback Mode is set to DISABLE, Oracle continues running in 
an online state on the node it has failed to. If the Oracle Failback Mode is set 
to AUTO, Oracle automatically moves back to its preferred node when the 
preferred node is brought back online. Set the Oracle Failback Mode to 
MANUAL to prevent Oracle from moving back to its preferred node when 
that node is brought back online, until you are ready to allow it to happen.

To view or change Oracle Start, Failover, and Failback modes:

� In ConsoleOne, right click the Oracle Resource object and select 
Properties.

� Click the Policies tab on the property page.

� View or change the Start, Failover or Failback modes for Oracle.
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View or Edit Oracle Resource Server Assignments

The Oracle resource template automatically assigns the Oracle resource to all 
nodes in the cluster. The order of assignment is the order the nodes appear in 
the resource list. To view or edit Oracle resource node assignments or change 
the server failover order:

� In ConsoleOne, right click the Oracle Resource object and select 
Properties

� Click the Nodes tab on the property page.

� View the current Oracle resource server assignments, and if necessary, 
click the right or left arrow button to assign or unassign servers to the 
Oracle resource.

You can click the up or down arrow button to change the failover order of 
the servers assigned to Oracle.

Additional NetWare Cluster Services Configuration Information

For additional information on setting up and configuring NetWare Cluster 
Services, go to NetWare Cluster Services.
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Configuring Netscape Enterprise 
Server with NetWare Cluster Services

Netscape Enterprise Server Installation and 
Configuration

Before configuring Netscape* Enterprise Server with NetWare® Cluster 
ServicesTM, Netscape Enterprise Server must be installed on each server in 
your cluster that will run it. See the Netscape Enterprise Server documentation 
for specific installation and setup instructions. In addition, the following 
Netscape Enterprise Server installation and configuration requirements must 
be met:

� The same administrator port number and password must be used on all 
servers in the cluster you install to.

� The default primary IP address (provided in the installation program for 
each server) must be used.

A secondary floating IP address is added after the installation.

� It is possible to configure Netscape Enterprise Server with no shared 
storage, but a shared disk system is recommended for all Web site related 
information. Cluster-enabling shared volumes is not recommended and 
not necessary for Netscape Enterprise Server to function with NetWare 
Cluster Services.

� Running Netscape Enterprise Server in the ACTIVE/ACTIVE mode is 
the recommended configuration because it provides faster recovery after 
a failure. ACTIVE/ACTIVE mode signifies that Netscape Enterprise 
Server is running simultaneously on multiple servers in the cluster. When 
a Web server fails, the Web sites on that server failover to other Web 
servers in the cluster. Only the Web sites move in ACTIVE/ACTIVE 
mode.
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Although not recommended, Netscape Enterprise Server can also be run 
in ACTIVE/PASSIVE mode. ACTIVE/PASSIVE mode signifies that 
Netscape Enterprise Server runs on only one node in the cluster at a time. 
When a Web server fails, Netscape Enterprise Server starts on other 
specified nodes in the cluster, and the Web sites that were on the failed 
server failover to other nodes in the cluster. This makes ACTIVE/
PASSIVE mode slower because Netscape Enterprise Server has to load 
on other servers in the cluster before Web sites can failover.

NetWare Cluster Services Configuration and Setup

Once Netscape Enterprise Server is installed, you must create and configure a 
Web site resource in NetWare Cluster Services for each Web site that will run 
on Netscape Enterprise Server. This includes configuring load and unload 
scripts; setting Start, Failover and Failback modes; and assigning the Web site 
resource to specific nodes in your cluster.

Creating a Web Server Cluster Resource

NetWare Cluster Services includes a Netscape Enterprise Server resource 
template, which greatly simplifies the process for creating a Web site cluster 
resource. Much of the Web site cluster resource configuration is perfomed 
automatically by the resource template.

To create a Web site cluster resource:

� In ConsoleOneTM, browse and select the Cluster object.

� Click File > New > Cluster > Cluster Resource.

� Enter a name for the Web site cluster resource.

� Enter the Netscape Enterprise Server template name in the Inherit From 
Template field, or browse and select it from the list.

� Click Create.

The Netscape Enterprise Server resource template configures the Web 
site resource by automatically creating load and unload scripts, setting 
Start, Failover and Failback modes and assigning the Web site as a 
resource to all nodes in the cluster. 

After creating a Web site resource, view or edit the resource to ensure it is 
configured correctly.
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Configuring Web Site Load and Unload Scripts

The Netscape Enterprise Server resource template automatically creates a load 
and unload script to start and stop the Web site on servers in your cluster. The 
load and unload scripts both contain IP address and volume-specific 
commands that you must customize for your specific Web server 
configuration.

To view or edit the Netscape Enterprise Server load and unload scripts:

� In ConsoleOne, right click the Netscape Enterprise Server Resource 
object and select Properties.

� Click the Load or Unload Script tab on the property page.

� Edit the IP address and volume-specific commands in both scripts.

For example, edit the following lines in the load script: 

nss /activate=VOLUME

mount VOLUME

add secondary ipaddress A.B.C.D

Replace VOLUME with the name of the Web server volume on the shared 
disk system. Replace A.B.C.D. with the desired IP address.

If you plan on running your Web server in ACTIVE/ACTIVE mode, you 
need to remove the NSWEB line from the load script and the NSWEBDN 
line from the unload script. In ACTIVE/ACTIVE mode, NSWEB is 
loaded automatically from the AUTOEXEC.NCF file of each server. 

Review the other lines in both scripts and edit them as necessary.

Setting Web Server Start, Failover, and Failback Modes

The Netscape Enterprise Server resource template sets the Web site resource 
Start Mode and Failover Mode to AUTO, and the Failback Mode to 
DISABLE.

If the Web site resource Start Mode is set to AUTO, the Web site automatically 
starts on a designated server when the cluster is first brought up. If the Web 
site Start Mode is set to MANUAL, you can manually start the Web site on a 
specific server when you want, instead of having it automatically start when 
servers in the cluster are brought up. 
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If the Web site Failover Mode is set to AUTO, the Web site automatically 
moves to the next server in the Assigned Nodes list in the event of a hardware 
or software failure. If the Web site Failover Mode is set to Manual, you can 
intervene after a failure occurs and before the Web site is moved to another 
node.

If the Web site Failback Mode is set to DISABLE, the Web site continues 
running in an online state on the node it has failed to. If the Web site Failback 
Mode is set to AUTO, the Web site automatically moves back to its preferred 
node when the preferred node is brought back online. Set the Web site 
Failback Mode to MANUAL to prevent the Web site from moving back to its 
preferred node when that node is brought back online, until you are ready to 
allow it to happen. 

To view or change Web site Start, Failover, and Failback modes:

� In ConsoleOne, right click the Netscape Enterprise Server Resource 
object and select Properties

� Click the Policies tab on the property page.

� View or change the Start, Failover or Failback modes for the Web site.

View or Edit Web Server Resource Node Assignments

The Netscape Enterprise Server resource template automatically assigns the 
Web site resource to all nodes in the cluster. The order of assignment is the 
order the nodes appear in the resource list. To view or edit Web site resource 
node assignments or change the Web site failover order:

� In ConsoleOne, right click the Netscape Enterprise Server Resource 
object and select Properties.

� Click the Nodes tab on the Netscape Enterprise Server resource property 
page.

� View the current Web site resource node assignments, and if necessary, 
click the right or left arrow button to assign or unassign nodes to the Web 
site resource.

You can click the up or down arrow button to change the failover order of 
the nodes assigned to the Web site.
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Hardware Virtual Server Installation and Configuration

If your cluster includes a shared disk system, each server that will run 
Netscape Enterprise Server must have the Hardware Virtual Server installed. 
To install and configure the Hardware Virtual Server:

� Connect to the Netscape administration server by entering the server’s IP 
address and port number on the URL line of your Web browser.

The port number is the administrator port number you entered during the 
installation. For example, if the server IP address is 123.45.67.200 and the 
administrator port number is 12345, enter

123.45.67.200:12345

� Click the Netscape Enterprise Server button (located on the main area 
below the button bar).

The button will have the same name as the NetWare server you are 
installing to.

� Click the Content Management button on the button bar and on the left 
frame, select Hardware Virtual Server.

� Enter the IP address that will be the dedicated IP address for the Web site.

The dedicated IP address is assigned to the Web site and will move with 
the Web site to specified servers in the cluster during failover and 
failback.

� Enter the Document root using the syntax vol1:/webroot, and click OK.

Replace vol1 with the name of the shared disk volume and webroot with 
the path to the top directory where Web content is located. Be sure to use 
a forward slash in the syntax instead of a backslash.


 Click the Save and Apply button at the bottom of the screen to complete 
the configuration.
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After installing Netscape Enterprise Server on specified servers in the cluster 
and configuring it to work with a shared disk system, you must add lines to the 
NVXWEBUP.NCF file of each Netscape Enterprise server in the cluster. 
These lines provide a work around for a known Netscape Enterprise Server 
problem. Add the following lines to the NVXWEBUP.NCF file of all servers 
that will be running the WebServer:

SET ALLOW IP ADDRESS DUPLICATES=ON

ADD SECONDARY IPADDRESS A.B.C.D

LOAD NSHTTPD -D /NOVONYX/SUITESPOT/HTTPS-SERVER/CONFIG

LOAD DELAY.NLM

DELAY 10

DEL SECONDAY IPADDRESS A.B.C.D

SET ALLOW IP ADDRESS DUPLICATES=OFF

Replace A.B.C.D with the IP address you will assign to the Web site. Since 
each Web site requires its own IP address, you will have to repeat the Add and 
Delete Secondary IP address lines for each Web site hosted on the Netscape 
Enterprise Web server.

The LOAD NSHTTPD line may already be present in the NVXWEBUP.NCF 
file. DELAY.NLM provides sufficient time for the Netscape daemon to load 
before the secondary IP addresses are deleted. The delay time required to 
properly load the Web Server varies according to hardware and server setup. 
Delay time should be altered to allow the Web Server to load properly.

After installing and configuring Netscape Enterpise Server and NetWare 
Cluster Services, if you want to run the Web server in ACTIVE/ACTIVE 
mode, run NSWEB.NCF to start Netscape Enterprise Server on each server in 
the cluster that will run the Web server. You can also reboot each server to 
have NSWEB.NCF automatically execute from each server’s 
AUTOEXEC.NCF file.

If you want Netscape Enterprise Server to run in ACTIVE/PASSIVE mode, 
remove the line that launches NSWEB.NCF from each server’s 
AUTOEXEC.NCF file and add lines to the Netscape Enterprise Server load 
and unload scripts to start and stop the Web server.
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Configuring BorderManager with 
NetWare Cluster Services

The Novell® BorderManagerTM Enterprise Edition 3.5 suite of software 
provides a variety of services—firewall/caching, VPN, and authentication 
services; however, this current release of NetWare® Cluster ServicesTM only 
provides failback, failover, and migration support for HTTP proxy services. 

To configure BorderManager with NetWare Cluster Services follow the 
guidelines and procedures in these sections:

� “BorderManager Installation and Configuration” on page 35

� “NetWare Cluster Services Configuration and Setup” on page 36

BorderManager Installation and Configuration

In order for BorderManager with NetWare Cluster Services to provide all its 
functionality and run correctly, BorderManager software must be properly 
installed and configured on each server. To install and configure 
BorderManager, refer to the following sections: 

Installing BorderManager

For BorderManager and NetWare Cluster Services to interoperate, you must 
install the BorderManager 3.5 Support Pack 1 along with your other 
BorderManager software. 

To install and set up BorderManager, see the BorderManager documentation 
at http://www.novell.com/documentation/lg/bmee3.5/docui/index.html for 
specific instructions.
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Configuring BorderManager

BorderManager HTTP proxy services can act as a forward proxy for a variety 
of application types, such as HTTPS, FTP, Simple Mail Transfer Protocol 
(SMTP), Network News Transfer Protocol (NNTP), and Gopher, and as a 
backward proxy or accelerator for HTTP Web servers. It can cache both 
forward- or backward-proxied content. Access is controlled via access control 
rules and user authentication. Because of this, when installing BorderManager 
on servers to be clustered, ensure that all BorderManager servers in the cluster 
are configured identically. In addition, shared storage is recommended for 
using BorderManager with NetWare Cluster Services, and is required if you 
are implementing BorderManager proxy caching.

Specifically, you must configure the BorderManager IP address and cache 
location to work with NetWare Cluster Services

To configure the BorderManager to support NetWare Cluster Services, 
complete the following steps:

� Start NetWare Administrator and select the BorderManager setup page 
for the desired server.

� Select IP Addresses and configure a virtual private IP address.

For Failover and Failback modes to function properly, this address should 
be the same for all proxy servers.

� Configure BorderManager to use caching. This will enhance both 
security and performance. For high availability, the cache directory 
should be located on the shared disk volume.

NetWare Cluster Services Configuration and Setup

Once BorderManager is installed and configured, you must create and 
configure a BorderManager proxy resource in NetWare Cluster Services. This 
includes configuring load and unload scripts, setting Failover and Failback 
modes, and assigning the resource to specific servers in your cluster.

Creating a BorderManager Proxy Resource

To create a BorderManager proxy resource, complete the following steps:

� In ConsoleOne, browse and select the cluster object.

� Click File > New > Cluster > Cluster Resource.
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� Enter a name for the BorderManager proxy cluster resource.

� If a template exists for the proxy resource, enter the template name in the 
Inherit From Template field, or browse and select a template from the list. 
If a template does not exist, check the Define Additional Properties check 
box.

� Click Create.

If you are not using a template for the proxy resource, continue with 
“Configuring BorderManager Proxy Load and Unload Scripts” on page 
37.

If you are not using a template, you must complete the process for 
creating the proxy cluster resource by configuring load and unload 
scripts, setting Failover and Failback modes, and changing the node 
assignments for the proxy resource, if necessary. 

If you are using a template for this resource, additional resource 
configuration is performed automatically by the template.

If you want to access the shared volume from a Novell ClientTM after failover, 
or if you want volume trustees migrated with the volume, you will need to 
cluster-enable the shared volume. For more information on cluster-enabling 
shared volumes, go to Setting Up NetWare Cluster Services, Cluster-Enable 
Volumes in NetWare Cluster Services Installation located at http://
www.novell.com/documentation/lg/ncs/docui/index.html (http://
www.novell.com/documentation/lg/ncs/docui/index.html).

Configuring BorderManager Proxy Load and Unload Scripts

Load and unload scripts are required by NetWare Cluster Services in order to 
start and stop the BorderManager proxy.

To configure BorderManager proxy resource load and unload scripts, 
complete the following steps:

� In ConsoleOneTM, right-click the BorderManager proxy resource object 
and select Properties.
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� Click the Load Script tab on the property page and add the following lines 
to the load script:

NSS /ACTIVATE SHARE1

MOUNT SHARE1

ADD SECONDARY IP ADDRESS 35.1.12.34

ADD SECONDARY IP ADDRESS 35.1.12.100

LOAD BRDSRV

Replace all occurrences of SHARE1 in the script example above with the 
name of the shared disk volume where the proxy directory resides.

Replace the 35.1.12.34 IP address in the script example with the IP 
address you have assigned to the shared volume. This will become the 
address for the Virtual Server object.

Replace the 35.1.12.100 IP address in the script example with the IP 
address you assigned to the BorderManager proxy during the 
BorderManager installation and setup.

� If you plan to cluster-enable a shared disk volume, add the following two 
lines to the load script immediately after the line to mount the shared disk 
volume:

TRUSTMIG SHARE1 WATCH

NUDP ADD ST_ORION_SHARE1_SERVER

Replace the SHARE1 variable in the script example above with the name 
of the shared disk volume where the proxy directory resides.

Replace ST_ORION_SHARE1_SERVER in the script example with the 
name you have assigned to the BorderManager Proxy resource (Virtual 
Server).
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� Click the Unload Script tab on the property page and add the following 
lines to the unload script: 

UNLOAD PROXY

UNLOAD IPXIPGW.NLM

UNLOAD BRDMON.NLM

UNLOAD PROXYCFG.NLM

UNLOAD ACLCHECK.NLM

UNLOAD NBMALERT.NLM

UNLOAD BRDSRV

DEL SECONDARY IPADDRESS 35.1.12.100

DEL SECONDARY IPADDRESS 35.1.12.34

DISMOUNT SHARE1 /FORCE

NSS /DEACTIVATE=SHARE1

Replace SHARE1 variable and IP addresses in the script example above 
with the appropriate values as described in Step 2.

� Add the following two lines to the unload script immediately before the 
line to dismount the shared disk volume:

NUDP DEL ST_ORION_SHARE1_SERVER 35.1.12.34

TRUSTMIG SHARE1 UNWATCH

Replace the ST_ORION_SHARE1_SERVER and SHARE1 variables in 
the script example above with the appropriate values as described in Step 
3.

Setting BorderManager Proxy Start, Failover, and Failback Modes

By default, NetWare Cluster Services sets the BorderManager proxy resource 
Start mode and Failover mode to AUTO, and the Failback mode to DISABLE. 

If the proxy resource Start mode is set to AUTO, the resource automatically 
loads on a designated server when the cluster is first brought up. If the proxy 
resource Start mode is set to MANUAL, you can manually start the proxy 
resource on a specific server when you want, instead of having it 
automatically start when servers in the cluster are brought up. 

If the proxy resource Failover mode is set to AUTO, the resource 
automatically moves to the next server in the Assigned Nodes list in the event 
of a hardware or software failure. If the proxy resource Failover mode is set to 
MANUAL, you can intervene after a failure occurs and before the resource is 
moved to another node.
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If the proxy resource Failback mode is set to DISABLE, the proxy resource 
continues running in an online state on the node to which it has failed. If the 
proxy resource Failback mode is set to AUTO, the proxy resource 
automatically moves back to its preferred node when the preferred node is 
brought back online. Set the proxy resource Failback mode to MANUAL to 
prevent the resource from moving back to its preferred node when that node 
is brought back online until you are ready to allow Failback to happen.

To view or change proxy resource Start, Failover, and Failback modes, 
complete the following steps:

� In ConsoleOne, right click the BorderManager Proxy Resource object 
and select Properties.

� Click the Policies tab on the property page.

� View or change the Start, Failover, or Failback modes for 
BorderManager.

Viewing or Editing BorderManager Proxy Resource Server 
Assignments

By default, NetWare Cluster Services automatically assigns the proxy 
resource to all nodes in the cluster. The order of assignment is the order that 
the nodes appear in the resource list.

To view or edit BorderManager proxy resource node assignments, or change 
the server failover order, complete the following steps:

� In ConsoleOne, right-click the BorderManager Proxy Resource object 
and select Properties.

� Click the Nodes tab on the property page.

� View the current proxy resource server assignments, and, if necessary, 
click the right or left arrow button to assign or unassign servers to the 
proxy resource.

You can click the up or down arrow button to change the failover order of 
the servers assigned to the BorderManager proxy.
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Configuring Netscape FastTrack Servers to Use Web Proxy

If you have deployed a Netscape* FastTrack* server to serve Web content in 
your network, this server must be configured to use or access a 
BorderManager Web proxy cluster.

To configure Netscape FastTrack to use a Web proxy cluster, complete the 
following steps:

� Launch Netscape.

� Select Edit > Preferences > Advanced > Proxies > Manual Proxy 
configuration > View. 

� Enter the virtual IP address and port number (8080) of the 
BorderManager proxy server in the HTTP, Security, and FTP fields.

Additional NetWare Cluster Services Configuration Information

For additional information on setting up and configuring NetWare Cluster 
Services, go to the NetWare Cluster Serviceshttp://www.novell.com/
documentation/lg/ncs/docui/index.html (http://www.novell.com/
documentation/lg/ncs/docui/index.html).
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Configuring NetWare 5.1 FTP Server 
with NetWare Cluster Services

NetWare 5.1 FTP Server Installation and Configuration

Before configuring NetWare® FTP Server with NetWare Cluster ServicesTM, 
NetWare FTP Server must be installed on each server in your cluster that will 
run it. See the NetWare FTP Server documentation for specific installation and 
setup instructions. NetWare FTP Server is selected by default during the 
NetWare 5.1 installation, and might already be installed.

Running FTP Server in Active/Active and Active/Passive Modes

Running FTP Server in the ACTIVE/ACTIVE mode is the recommended 
configuration because it provides faster recovery after a failure. ACTIVE/
ACTIVE mode signifies that FTP Server is running simultaneously on 
multiple servers in the cluster. When a Web server fails, the FTP sites on that 
server fail over to other FTP servers in the cluster. Only FTP sites move in 
ACTIVE/ACTIVE mode.

NetWare FTP Server can also be run in ACTIVE/PASSIVE mode. ACTIVE/
PASSIVE mode signifies that FTP Server runs on only one node in the cluster 
at a time. When a Web server fails, NetWare FTP Server starts on other 
specified nodes in the cluster, and the FTP sites that were on the failed server 
fail over to other nodes in the cluster. This makes ACTIVE/PASSIVE mode 
marginally slower because NetWare FTP Server has to load on other servers 
in the cluster before FTP sites can fail over.
Configuring NetWare 5.1 FTP Server with NetWare Cluster Services 
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Edit FTPSERV.CFG Configuration Files

The configuration file FTPSERV.CFG is created by default during the FTP 
Server installation and is placed in the SYS:\ETC directory. A separate 
FTPSERV.CFG file exists for each FTP Server that is installed on the cluster. 

Each FTPSERV.CFG file contains a line that specifies the IP address assigned 
to the FTP server. By default, the IP address assigned to the FTP server is the 
same IP address that is assigned to the NetWare server where the FTP server 
resides. 

A separate unique IP address must be assigned to the FTP server so that it can 
move with the FTP server during failover and failback. Edit the 
FTPSERV.CFG file and change the HOST_IP_ADDR line to specify the 
unique IP address you want to assign to the FTP server. For example, if the 
unique IP address you want to assign to the FTP server is 123.45.67.012, the 
line reads Host_IP_ADDR=123.45.67.012. 

Assigning a unique IP address to the FTP server allows the FTP server to bind 
to the unique IP address instead of to the IP address of the local host.

FTPSERV.CFG also contains a line that specifies the default home directory 
for FTP users. This home directory must reside on a volume on the shared disk 
system. The volume where the home directory resides doesn’t have to be 
cluster-enabled.

Edit FTPSERV.CFG and change the DEFAULT_USER_HOME line to 
specify the user home directory and volume on the shared disk system. For 
example, if the user home directory on the shared volume is SHARE1:/
HOME, the line would read DEFAULT_USER_HOME=SHARE1:HOME. 

Edit AUTOEXEC.NCF Files

If you are running FTP Server in ACTIVE/PASSIVE mode, FTP Server 
should be launched from the FTP Server Cluster Resource load script. See 
“NetWare Cluster Services Configuration and Setup” on page 30. 

If you are running FTP Server in ACTIVE/ACTIVE mode, FTP Server should 
be launched from the AUTOEXEC.NCF file of each NetWare server in the 
cluster that will run FTP Server. 


 Resource Configuration Guide

Resource Configuration Guide
Place Part Number Here

February 5, 2001



Manual Rev 99a28 9 June 00
Add the following lines in the order specified to the AUTOEXEC.NCF file of 
each NetWare server in the cluster that will run FTP Server in ACTIVE/
ACTIVE mode:

SET ALLOW IP ADDRESS DUPLICATES=ON

ADD SECONDARY IPADDRESS A.B.C.D

NWFTPD

LOAD DELAY.NLM

DELAY 5

DEL SECONDARY IPADDRESS A.B.C.D

SET ALLOW IP ADDRESS DUPLICATES=OFF

Replace A.B.C.D with the unique IP address you assigned the FTP server.

If you are running multiple FTP servers on your cluster, repeat the ADD and 
DELETE SECONDARY IP ADDRESS lines for each FTP server, since each 
FTP server requires its own IP address. Also, each FTP server must also have 
its own uniquely named configuration file which specifies the FTP server’s IP 
address and shared volume directory. Running FTP Server in ACTIVE/
ACTIVE mode is required if you plan to run more than one FTP Server on the 
same NetWare server.

For example, if you have three FTP servers on your cluster, you can create 
three configuration files named FTPSERV1.CFG, FTPSERV2.CFG, and 
FTPSERV3.CFG and copy them to the SYS:\ETC directory of each NetWare 
server in the cluster that will run the FTP servers. Each configuration file 
contains the IP address and shared volume directory for its corresponding FTP 
server. In this example, you would add the following lines to the 
AUTOEXEC.NCF file of each server in the cluster that will run the three FTP 
servers in ACTIVE/ACTIVE mode: 

SET ALLOW IP ADDRESS DUPLICATES=ON

ADD SECONDARY IPADDRESS A.B.C.D

ADD SECONDARY IPADDRESS A.B.C.D

ADD SECONDARY IPADDRESS A.B.C.D

NWFTPD -C FTPSERV1.CFG

NWFTPD -C FTPSERV2.CFG

NWFTPD -C FTPSERV3.CFG

LOAD DELAY.NLM

DELAY 5

DEL SECONDARY IPADDRESS A.B.C.D

DEL SECONDARY IPADDRESS A.B.C.D
Configuring NetWare 5.1 FTP Server with NetWare Cluster Services 
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DEL SECONDARY IPADDRESS A.B.C.D

SET ALLOW IP ADDRESS DUPLICATES=OFF

DELAY.NLM provides enough time for the FTP server to load before the 
secondary IP addresses are deleted. The delay time might need to be altered to 
ensure enough time is allotted.

If you are also running Netscape Enterprise Server in ACTIVE/ACTIVE 
mode on the same server, add the lines in the above example before the 
NSWEB command.

NetWare Cluster Services Configuration and Setup

Once FTP Server is installed, you must create and configure an FTP server 
resource in NetWare Cluster Services for each FTP server that will run in your 
cluster. This includes configuring load and unload scripts; setting Start, 
Failover and Failback modes; and assigning the FTP server resource to 
specific nodes in your cluster.

Creating an FTP Server Cluster Resource

To create an FTP server cluster resource:

� In ConsoleOneTM, browse and select the Cluster object.

� Click File > New > Cluster > Cluster Resource.

� Enter a name for the FTP server cluster resource.

� If a template exists for the FTP server resource, enter the template name 
in the Inherit From Template field, or browse and select it from the list. If 
a template does not exist, check the Define Additional Properties check 
box

� Click Create.

If you are not using a template for the proxy resource, continue with 
“Configuring Web Site Load and Unload Scripts” on page 31. 

If you are not using a template, you must complete the process for 
creating the FTP server cluster resource by configuring load and unload 
scripts, setting failover and failback modes, and changing the node 
assignments for the FTP server resource (if necessary). 

If you are using a template for this resource, additional resource 
configuration is performed automatically by the template.
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After creating an FTP server resource, view or edit the resource to ensure it is 
configured correctly.

Configuring FTP Server Load and Unload Scripts

Load and unload scripts are required by NetWare Cluster Services to start and 
stop the FTP server.

To configure the FTP Server resource load and unload scripts:

� In ConsoleOne, right click the FTP Server Resource object and select 
Properties.

� Click the Load Script tab on the property page and add the following lines 
to the load script:

NSS /ACTIVATE=VOLUME

MOUNT VOLUME

ADD SECONDARY IPADDRESS A.B.C.D

NWFTPD

� Click the Unload Script tab on the property page and add the following 
lines to the unload script:

UNLOAD NWFTPD

DISMOUNT VOLUME /FORCE

NSS /FORCEDEACTIVATE=VOLUME

DEL SECONDARY IPADDRESS A.B.C.D

Replace VOLUME in both the load and unload scripts with the name of 
the shared disk volume where webroot exists. Replace A.B.C.D. with the 
secondary IP address assigned to the FTP server resource. This is the IP 
address that will move with the FTP Server during failover and failback. 
The NWFTPD command is omitted in ACTIVE/ACTIVE mode.

Setting FTP Server Start, Failover, and Failback Modes

By default, NetWare Cluster Services sets the FTP server resource Start Mode 
and Failover Mode to AUTO, and the Failback Mode to DISABLE.

If the FTP Server resource Start Mode is set to AUTO, the FTP Server 
automatically starts on a designated server when the cluster is first brought up. 
If the FTP Server Start Mode is set to MANUAL, you can manually start the 
FTP Server on a specific server when you want, instead of having it 
automatically start when servers in the cluster are brought up. 
Configuring NetWare 5.1 FTP Server with NetWare Cluster Services 
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If the FTP Server Failover Mode is set to AUTO, the FTP Server automatically 
moves to the next server in the Assigned Nodes list in the event of a hardware 
or software failure. If the FTP Server Failover Mode is set to MANUAL, you 
can intervene after a failure occurs and before the FTP Server is moved to 
another node.

If the FTP Server Failback Mode is set to DISABLE, the FTP Server continues 
running in an online state on the node it has failed to. If the FTP Server 
Failback Mode is set to AUTO, the FTP Server automatically moves back to 
its preferred node when the preferred node is brought back online. Set the FTP 
Server Failback Mode to MANUAL to prevent the FTP Server from moving 
back to its preferred node when that node is brought back online, until you are 
ready to allow it to happen. 

To view or change FTP Server Start, Failover, and Failback modes:

� In ConsoleOne, right click the FTP Server Resource object and select 
Properties.

� Click the Policies tab on the property page.

� View or change the Start, Failover or Failback modes for the FTP server.

View or Edit FTP Server Resource Node Assignments

By default, NetWare Cluster Services automatically assigns the FTP Server 
resource to all nodes in the cluster. The order of assignment is the order the 
nodes appear in the resource list. 

To view or edit the FTP Server resource node assignments or change the server 
failover order:

� In ConsoleOne, right click the FTP Server Resource object and select 
Properties.

� Click the Nodes tab on the FTP Server Resource property page.

� View the current FTP Server resource node assignments, and if necessary, 
click the right or left arrow button to assign or unassign nodes to the FTP 
Server resource.

You can click the up or down arrow button to change the failover order of 
the nodes assigned to the FTP Server Resource.
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Configuring ZENworks for Desktops 2 
with NetWare Cluster Services

ZENworks for Desktops Installation and Configuration

Before running ZENworksTM for Desktops 2 (ZfD) with NetWare® Cluster 
ServicesTM, you must have at least two NetWare 5.x servers. You must also 
have NetWare Cluster Services installed and running on each of the servers 
that will be part of your cluster. A cluster-enabled shared disk volume (also 
called a virtual server) is also required prior to installing and configuring ZfD 
with NetWare Cluster Services. For more information on cluster-enabling 
shared volumes, go to Cluster-Enable Volumes in NetWare Cluster Services.

Because of some limitations of the current ZfD installation procedure for 
installing into a cluster environment, you must change the installation 
procedure to account for the install location of ZfD files, for the ZENworks 
Inventory database mechanism and service, and for the behavior of NetWare 
Clients shipped and installed with ZENworks for Desktops 2.

During the ZfD installation, some files are copied to the SYS:PUBLIC 
directory of the server where ZfD is installed. These ZfD files must reside on 
the shared disk volume for ZfD to function properly with NetWare Cluster 
Services. To avoid problems, copy the entire SYS:PUBLIC directory to the 
shared disk volume and run all ZfD components from that volume.

An option in the ZfD installation allows you to install the ZENworks 
Inventory database to the volume of your choice. You must install the 
Inventory database on the shared disk volume for ZfD to function properly 
with NetWare Cluster Services. The installation also creates a configuration 
file (STORER.NCF). This file includes a line specifying the address of the 
server currently running the Inventory database. You must modify this line to 
include the address of the shared disk volume.
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Application Object Templates (AOTs) must be stored on the shared disk 
volume. Some AOTs are installed automatically by ZfD. You must move these 
AOTs to the shared disk volume and update their SOURCE_PATH macro to 
point to the shared disk volume.

The ZfD installation also adds lines to the server’s AUTOEXEC.NCF file that 
load certain ZENworks services. You must comment these lines in the file and 
add them to the volume load script. You must also add similar lines to the 
volume unload script to unload these ZENworks services.

Installing ZENworks for Desktops 2

ZENworks for Desktops 2 must be installed on at least two servers in the 
cluster.

To install ZENworks for Desktops 2:

� Log in as Admin to the NDS tree where your cluster resides. Specify the 
IP address of the cluster-enabled volume in the Server field.

If you have trouble accessing the cluster-enabled volume after logging in, 
ensure you have the client required by NetWare Cluster Services.

� Map a drive to the shared disk volume, specifying or selecting the name 
you assigned the cluster-enabled volume (virtual server).

The cluster-enabled shared disk volume will host the ZENworks 
Inventory database. Mapping a drive to the shared disk volume allows the 
ZfD installation program to access the shared volume and install the 
Inventory database to it.

� Insert the ZENworks for Desktops 2 product CD and install the product.

Follow the instructions provided in the installation dialog boxes.

During the installation, you will be prompted to select an NDS tree and a 
server. Select the NDS tree where your cluster resides and the cluster-
enabled shared disk volume (virtual server).

� Migrate the cluster-enabled shared disk volume to another server in your 
cluster and repeat Step 3 to install ZfD on that server.

See Migrate Resources in NetWare Cluster Services.

� Repeat Steps 3 and 4 on each server where ZfD is to be installed.
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Configuring ZENworks for Desktops 2

After installing ZENworks for Desktops 2, you must modify certain 
configuration files on each of the servers in the cluster where it was installed.

To modify the configuration files:

� Using a text editor, open the STORER.NCF file on one of the cluster 
servers where ZfD was installed.

The file can be found at SYS:\PUBLIC\ZENWORKS\JAVA.

� Edit the following line in the STORER.NCF file:

JAVA -NS 
COM.NOVELL.ZENWORKS.DESKTOP.INVENTORY.STORER.LOADER-
DBLOK IP address

Replace IP address with the IP address of the cluster-enabled shared 
volume and save the file.

� Using a text editor, open the AUTOEXEC.NCF file on the same server.

� Copy the lines in the AUTOEXEC.NCF file that were created by the ZfD 
installation and paste them into a blank text file.

The ZENworks section in the AUTOEXEC.NCF file starts with 

SEARCH ADD SYS:\PUBLIC\ZENWORKS\JAVA 

and ends with 

SYS:\PUBLIC\ZENWORKS\JAVA\STORER.NCF

You will later use the text file to add commands to NetWare Cluster 
Services load and unload scripts.

� Comment out or delete the ZENworks lines in the AUTOEXEC.NCF file, 
and save the file.


 Repeat Steps 1, 2, 3, and 5 for all servers in the cluster that have ZfD 
installed.

NetWare Cluster Services Configuration and Setup

When ZENworks for Desktops 2 is installed and configured, you must edit the 
load and unload scripts for the cluster-enabled volume that was used during 
the ZfD installation. You must also set Start, Failover and Failback modes for 
the cluster-enabled volume and assign the volume to specific nodes in your 
cluster.
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Configuring ZENworks for Desktops 2 Cluster Volume Load and 
Unload Scripts

Load and unload scripts are required by NetWare Cluster Services to mount 
and dismount cluster-enabled volumes on different servers in the cluster.

To edit the cluster-enabled volume load and unload scripts:

� In ConsoleOneTM, right-click the Cluster Volume object and select 
Properties.

� Click the Load Script tab on the property page and copy the lines from the 
text file you created in the previous section. Paste the lines in the load 
script immediately after the command to mount the cluster volume.

The following ZENworks specific commands should now appear in the 
cluster volume load script:

SEARCH ADD SYS:\PUBLIC\ZENWORKS\JAVA

LOAD JAVA.NLM

SYS:\SYSTEM\JVORBCFG.NET

LOAD ORBCMD.NLM

LOAD OSAGENT.NLM

SYS:\PUBLIC\ZENWORKS\JAVA\ALARMMGR.NCF

SEARCH ADD SHAREDVOL:\ZENWORKS\DATABASE

SHAREDVOL:\ZENWORKS\DATABASE\SYBASE.NCF

SYS:\SYSTEM\GATHERE.NCF

SYS:\PUBLIC\ZENWORKS\JAVA\MASTER.NCF

SYS:\PUBLIC\ZENWORKS\JAVA\STORER.NCF

Replace all occurrences of SHAREDVOL with the name of the cluster-
enabled volume.

� Click the Unload Script tab on the property page and add the following 
lines immediately prior to the volume dismount command: 

UNLOAD DBSRV6.NLM <<Y

UNLOAD ZENINV

UNLOAD SNMPLOG

UNLOAD OSAGENT

UNLOAD ORBCMD

UNLOAD JAVA
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The UNLOAD JAVA command will close all Java processes. This means 
that all Java-based applications currently running, including ConsoleOne, 
will be terminated.

Setting Cluster Volume Start, Failover, and Failback Modes

By default, NetWare Cluster Services sets the cluster volume Start Mode and 
Failover Mode to AUTO, and the Failback Mode to DISABLE. If the cluster 
volume Start Mode is set to AUTO, the volume automatically mounts on a 
server when the cluster is first brought up. If the cluster volume Start Mode is 
set to MANUAL, you can manually mount the cluster volume on a server at 
your discretionm, rather than having it automatically mount when servers in 
the cluster are brought up. 

If the cluster volume Failover Mode is set to AUTO, the cluster volume 
automatically mounts on the next server in the Assigned Nodes list in the 
event of a hardware or software failure. If the cluster volume Failover Mode 
is set to MANUAL, you can intervene after a failure occurs and before the 
cluster volume mounts on another server.

If the cluster volume Failback Mode is set to DISABLE, the volume will not 
fail back to its most preferred node when the most preferred node rejoins the 
cluster. If the cluster volume Failback Mode is set to AUTO, the volume will 
automatically fail back to its most preferred node when the most preferred 
node rejoins the cluster. Set the cluster volume Failback Mode to MANUAL 
to prevent the volume from moving back to its preferred node when that node 
is brought back online, until you are ready to allow it to happen. 

To view or change cluster volume Start, Failover, and Failback modes:

� In ConsoleOne, right-click the Cluster Volume object and select 
Properties.

� Click the Policies tab on the property page.

� View or change the Start, Failover or Failback modes for the Cluster 
Volume.
Configuring ZENworks for Desktops 2 with NetWare Cluster Services �	
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Setting Cluster Volume Server Assignments

NetWare Cluster Services by default assigns the cluster volume resource to all 
nodes in the cluster. The order of assignment is the order the nodes appear in 
the resource list. To view or edit cluster volume resource node assignments or 
change the server failover order:

� In ConsoleOne, right-click the Cluster Volume Resource object and select 
Properties.

� Click the Nodes tab on the property page.

� View the current cluster volume resource server assignments, and if 
necessary, click the right or left arrow button to assign or unassign servers 
to the cluster volume resource.

You can click the up or down arrow button to change the failover order of 
the servers assigned to the cluster volume.

Copying ZENworks for Desktops 2 Directories and Updating 
Components 

After installing and configuring ZENworks for Desktops 2 and NetWare 
Cluster Services, you must perform some additional configuration to ensure 
that ZfD will function properly with NetWare Cluster Services. 

� From one of the cluster servers that has ZfD installed, copy the 
SYS:PUBLIC directory to the root of the shared cluster volume.

ZENworks for Desktops 2 installs several files in the SYS:PUBLIC 
directory. Most of these files must reside on the shared cluster volume for 
ZfD to function properly with NetWare Cluster Services. To save time 
and avoid potential problems, copy the entire SYS:\PUBLIC directory 
rather than trying to determine exactly which files are necessary.

� Use NetWare Administrator to modify the AOT files that were installed 
by ZfD.

 The AOT files must be modified to point to the shared cluster volume.

� Reboot or restart each cluster server where ZfD was installed.

Additional NetWare Cluster Services Configuration Information

For additional information on setting up and configuring NetWare Cluster 
Services, go to NetWare Cluster Services.
�
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Configuring ZENworks for Servers 
with NetWare Cluster Services

ZENworks for Servers Installation and Configuration

Before running ZENworksTM for Servers with NetWare® Cluster ServicesTM, 
you must have:

� At least two NetWare 5.x servers.

� NetWare Cluster Services installed and running on each of the servers that 
will be part of your cluster.

� A cluster-enabled shared disk volume (also called a virtual server) 
configured. For more information on cluster-enabling shared volumes, go 
to Cluster-Enable Volumes  in NetWare Cluster Services.

� The Tiered Electronic Distribution (TED) portion of ZENworks for 
Servers installed on each server in your cluster that will host the 
Distributor or Subscriber service. See the ZENworks for Servers 
documentation for specific installation and setup instructions.

The primary benefit for configuring ZENworks for Servers with NetWare 
Cluster Services is to ensure high availability of the Tiered Electronic 
Distribution (TED) portion of ZENworks for Servers. Configuring TED with 
NetWare Cluster Services ensures the transmission and reception of critical 
data and software updates. 

By default, the ZENworks for Servers naming service associates itself with the 
IP address of the physical server instead of the IP address of the virtual server. 
This is why the virtual server cannot be used as a Distributor. It is also the 
reason the ZEN for Servers Proxy cannot be used with NetWare Cluster 
Services. 
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The ZEN for Servers Distributor can be configured to work with NetWare 
Cluster Services without associating it with the IP address of the virtual server. 
It is recommended that the virtual server (cluster enabled shared disk volume) 
be used to store the data to be distributed so data can be distributed regardless 
of which physical server holds the connection. See “Configuring the 
ZENworks for Servers Distributor” on page 56. 

The ZEN for Servers Subscriber can also be configured to work with NetWare 
Cluster Services. Adding a Subscriber to the cluster can be useful if the 
Subscriber is also a Web server or a database server that you want to ensure is 
always available to receive updates. See “Configuring the ZENworks for 
Servers Subscriber” on page 57.

Configuring the ZENworks for Servers Distributor

Each ZENworks for Servers Distributor in the cluster must be configured 
specifically to work with NetWare Cluster Services. See the ZENworks for 
Servers documentation for more information. 

To configure the ZENworks for Servers Distributors:

� Edit the Distributor objects and assign each Distributor a unique channel.

� Create a separate subscription on every Subscriber for each of the 
channels.

Each server in the cluster acting as a Distributor will be set up as a 
separate Distributor. NetWare Cluster Services uses the virtual server to 
ensure high-availability of data transmissions.

� Create the contents of the distribution on the shared volume. 

This includes any data or software updates that you plan to distribute.

� Migrate the shared volume to each of the servers in the cluster hosting a 
distributor and recreate the same distribution for every Distributor and 
channel that will host it.

See Migrate Resources in NetWare Cluster Services.

� Modify the NS.NCF and DIST.NCF files (located in the SYS:\TED 
directory of each Distributor) and add a JAVA function to tag both the 
naming service and distributor service with unique IDs so both services 
can be unloaded from the resource unload script.
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�� Open the NS.NCF file and find the following line:

java -noclassgc -classpath $nspath 
com.novell.orb.service.naming.NamingServer

Add a -jsXXXX switch to the line. Replace XXXX with any unique 
indentifier you want. For example, if you replaced XXXX with nsexit, 
the line would appear as follows:

java -jsnsexit -noclassgc -classpath $nspath 
com.novell.orb.service.naming.NamingServer

�� Open the DIST.NCF file and find the following line:

java -ns -noclassgc -mx64m -classpath $tedpathd 
-DTree.name=DTST -Cluster 
-DNode.name=distributor_clust_SYS_server.server
.novell -DNode.location=SYS:\TED 
com.novell.application.zenworks.ssd.core
.distributor.Distributor

Add a -jsXXXX switch to the line. Replace XXXX with any unique 
identifier you want. For example, if you replaced XXXX with distexit, 
the line would appear as follows:

java -jsdistexit -ns -noclassgc -mx64m -classpath 
$tedpathd -DTree.name=DTST -Cluster 
-DNode.name=distributor_clust_SYS_server.server.no
vell -DNode.location=SYS:\TED 
com.novell.application.zenworks.ssd.core.distribut
or.Distributor

Configuring the ZENworks for Servers Subscriber

You can optionally add servers containing the ZENworks for Servers 
Subscriber to your cluster to ensure distributed data and software updates are 
always received. See the ZENworks for Servers documentation for more 
information. 

To configure the ZENworks for Servers Subscribers:

� For each Subscriber in the cluster, configure the working directory and 
Log file location to point to the shared volume. Otherwise, configure each 
Subscriber as you normally would.

This ensures that data is placed on the shared volume independent of 
which physical server hosts the subscriber service.
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� Modify the NS.NCF and SUB.NCF files (located in the SYS:\TED 
directory of each Subscriber) and add a JAVA function to tag both the 
naming service and subscription service with unique IDs so both services 
can be unloaded from the resource unload script.

�� Open the NS.NCF file and find the following line:

java -noclassgc -classpath $nspath 
com.novell.orb.service.naming.NamingServer

Add a -jsXXXX switch to the line. Replace XXXX with any unique 
indentifier you want. For example, if you replaced XXXX with nsexit, 
the line would appear as follows:

java -jsnsexit -noclassgc -classpath $nspath 
com.novell.orb.service.naming.NamingServer

�� Open the SUB.NCF file and find the following line:

java -ns -noclassgc -mx64m -classpath $tedpathd 
-DTree.name=DTST -Cluster 
-DNode.name=subscriber_clust_SYS_server.server
.novell -DNode.location=SYS:\TED 
com.novell.application.zenworks.ssd.core
.subscriber.Subscriber

Add a -jsXXXX switch to the line. Replace XXXX with any unique 
identifier you want. For example, if you replaced XXXX with subexit, 
the line would appear as follows:

java -jssubexit -ns -noclassgc -mx64m -classpath 
$tedpathd -DTree.name=DTST -Cluster 
-DNode.name=subscriber_clust_SYS_server.server
.novell -DNode.location=SYS:\TED 
com.novell.application.zenworks.ssd.core
.subscriber.Subscriber

NetWare Cluster Services Configuration and Setup

Once ZENworks for Servers is installed and configured, you must edit the 
load and unload scripts for the cluster-enabled volume that was used during 
the ZENworks for Servers installation. You must also set Start, Failover and 
Failback modes for the cluster-enabled volume and assign the volume to 
specific nodes in your cluster.
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Configuring ZENworks for Servers Cluster Volume Load and Unload 
Scripts

Load and unload scripts are required by NetWare Cluster Services to mount 
and dismount cluster-enabled volumes on different servers in the cluster. 
Commands can also be added to the cluster-enabled volume load and unload 
scripts to run or launch programs.

To edit cluster-enabled volume load and unload scripts:

� In ConsoleOneTM, right-click the Cluster Volume object and select 
Properties.

� If the cluster-enabled volume is hosting a Distributor, click the Load 
Script tab on the property page and add the following line to the load 
script: 

SYS:\TED\DIST

If the cluster-enabled volume is hosting a Subscriber, click the Load 
Script tab on the property page and add the following line to the load 
script.

SYS:\TED\SUB

� For Distributors, click the Unload Script tab on the property page and add 
the following lines to the cluster-enabled volume unload script: 

java -killdistexit

java -killnsexit

Replace distexit with the unique identifier you used in the DIST.NCF file. 
Replace nsexit with the unique identifier you used in the NS.NCF file.

For Subscribers, click the Unload Script tab on the property page and add 
the following lines to the cluster-enabled volume unload script:

java -killsubexit

java -killnsexit

Replace subexit with the unique identifier you used in the SUB.NCF file. 
Replace nsexit with the unique identifier you used in the NS.NCF file.
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Setting Cluster Volume Start, Failover, and Failback Modes

By default, NetWare Cluster Services sets the cluster volume Start Mode and 
Failover Mode to AUTO, and the Failback Mode to DISABLE. 

If the cluster volume Start Mode is set to AUTO, the cluster volume 
automatically mounts on a designated server when the cluster is first brought 
up. If the cluster volume Start Mode is set to MANUAL, you can manually 
mount the volume on a specific server at your discretion, rather than having it 
automatically mount when servers in the cluster are brought up. 

If the cluster volume Failover Mode is set to AUTO, the volume automatically 
mount on the next server in the Assigned Nodes list in the event of a hardware 
or software failure. If the cluster volume Failover Mode is set to MANUAL, 
you can intervene after a failure occurs and before the volume mounts on 
another server.

If the cluster volume Failback Mode is set to DISABLE, the volume will not 
fail back to its most preferred node when the most preferred node rejoins the 
cluster. If the cluster volume Failback Mode is set to AUTO, the volume will 
automatically fail back to its most preferred node when the most preferred 
node rejoins the cluster. Set the cluster volume Failback Mode to MANUAL 
to prevent the volume from moving back to its preferred node when that node 
is brought back online, until you are ready to allow it to happen. 

To view or change cluster volume Start, Failover, and Failback modes:

� In ConsoleOne, right-click the cluster volume object and select 
Properties.

� Click the Policies tab on the property page.

� View or change the Start, Failover or Failback modes for the cluster 
volume.

Setting Cluster Volume Server Assignments

NetWare Cluster Services by default assigns the cluster volume resource to all 
nodes in the cluster. The order of assignment is the order the nodes appear in 
the resource list. To view or edit cluster volume resource node assignments or 
change the server failover order: 

� In ConsoleOne, right-click the Cluster Volume Resource object and select 
Properties.

� Click the Nodes tab on the property page.
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� View the current cluster volume resource node assignments, and if 
necessary, click the right or left arrow button to assign or unassign servers 
to the cluster volume resource.

You can click the up or down arrow button to change the failover order of 
the servers assigned to the cluster volume resource.

Additional NetWare Cluster Services Configuration Information

For additional information on setting up and configuring NetWare Cluster 
Services, go to NetWare Cluster Services.
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Configuring NSS Mirroring with 
NetWare Cluster Services

NSS mirroring is intended as a solution for remote mirroring in installations 
where disaster recovery is required. If you have a regular RAID drive array, 
We recommend using hardware-powered drive redundancy instead of NSS 
mirroring. 

Hardware configuration and placement for NSS mirroring can vary depending 
on geography and fault tolerance requirements. For example, the following 
figure depicts a simple hardware configuration in which one side of the 
mirrored NSS volume is located in a separate building from the rest of the 
cluster hardware.
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The following figure depicts a more complex hardware configuration in which 
two clusters are placed in separate buildings, but each has one side of a 
mirrored NSS volume in the building with the other cluster.
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Configure NSS Mirroring

NSS mirroring must be configured before creating NSS volumes and cluster-
enabling them. If you already have NSS volumes configured, you should back 
up the data on the volumes, configure NSS mirroring as described below, and 
then restore the data to the mirrored NSS volumes. Consider the following 
recommendations before configuring NSS mirroring.

� Each server must have a unique ID which can be set with the MM 
ASSIGN SERVER ID = STRING command. We recommend using the 
cluster node name for the string.
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� Mirrored virtual devices can be active on only one server at a time. 
Cluster nodes assign and release ownership of mirrored virtual devices, 
which is exactly the same as cluster nodes activating or deactivating non-
mirrored NSS volumes. This means any NSS volume created on a 
mirrored virtual device can be active on only one node, which is the node 
that acquired ownership of the mirrored virtual device that contains the 
volume. 

We recommend that you configure mirrored virtual devices to contain 
one volume at a time. It is possible to configure more than one volume per 
mirrored virtual device, but you must ensure that all volumes are mounted 
on the same node. For this reason, We recommend one NSS volume per 
mirrored virtual device. If you want more than one mirrored NSS volume, 
then create additional mirrored virtual devices with one NSS volume per 
mirrored virtual device.

Create, Mirror, and Label Virtual Device Partitions

Prior to creating and mirroring virtual device partitions, ensure that you have:

� NetWare 5.1 Support Pack 1 installed on all servers that will be part of 
the cluster.

� All servers in the cluster connected to a shared storage system.

� One or more drive arrays configured on the shared storage system.

� 10 MB of free space on the shared storage system for a special cluster 
partition.

All servers in the cluster must also have unique IDs assigned to them before 
you create and mirror virtual device partitions. To assign server IDs, edit the 
AUTOEXEC.NCF file on each server and add the following lines before any 
NSS commands:

mm assign server id=serverid

scan for new partitions on FFFFFFFF

Replace serverid with the unique name you want to assign the server. The 
name has a maximum length of 16 characters. You might want to use the 
server name or a descriptive name like ClusterNode 1, ClusterNode 2, etc. The 
scan for new partitions command ensures all partition information is reset.
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To create virtual device partitions: 

� In NWCONFIG select Standard Disk Options and then select Modify 
Disk Partitions and Hot Fix.

� Choose a storage array and select Create Virtual Device Partition.

� Enter the partition size and create the virtual partition.

Note the size of the partition and its Logical ID. You will need this 
information when you create and mirror the second partition.

� Create a partition table by going to the previous menu and selecting the 
Virtual Device Partition you just created.

� Repeat Steps 1 through 4 to create a virtual device partition on the second 
storage array you want to mirror.

To mirror virtual device partitions:

� In NWCONFIG, select Standard Disk Options > Mirror/Unmirror Disk 
Partitions.

� Select the logical ID of one of the partitions.

� Press Insert and select the logical ID of the other partition.

� Press ESC and wait for the partitions to mirror.

To label virtual device partitions on one mirrored partition:

� Load VRDEV.NLM, type vrdev /list partitions, and note the 
ID values for the two partitions.

For example, one partition ID might be 0xD and the other might be 0x10. 
Only one partition ID is shown per virtual disk partition.

� Label each partition with the same name by typing the following 
commands at the server console:

mm assign partition label pid#1=partition_name

mm assign partition label pid#2=partition_name

Replace pid#1and pid#2 with the partition ID values you noted in step 1. 
Replace partition_name with the name you are assigning the mirrored 
partition. 

For example, if the partition IDs are 0xD and 0x10, and the partition name 
is nssmirror, the commands would appear as follows:

mm assign partition label 0xD=nssmirror

mm assign partition label 0x10=nssmirror
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� Type vrdev /list partitions at the server console and verify 
that partition names have been assigned.

Create an NSS Volume and Update .NCF Files

Once a virtual device partition has been created, labeled and mirrored, you 
must create an NSS volume on that partition. To create an NSS volume on the 
virtual partition:

� In NWCONFIG select NSS Disk Options > Storage > Update Provider 
Information > NSS Media Mgr. Provider.

� Select Assign Ownership and then select the free space that represents the 
mirrored partition.

� Enter the size of the NSS Partition, then return to the previous menu and 
select NSS Volume Options.

� Enter your admin context and the admin password as prompted.

� Select Create > Storage Group > the NSS partition that was created > NSS 
Volume > the NSS partition that was created, and then enter the size and 
name for the NSS volume.

After creating an NSS volume, you must check the AUTOEXEC.NCF files 
and edit the STARTUP.NCF files on all servers in the cluster before restarting 
them.

� Ensure the following line is in the AUTOEXEC.NCF file on each server 
in the cluster.

NSS /AutodeactivateVol=All

This command must be placed after lines to assign server IDs and scan for 
new partitions.

� Add the following line to the STARTUP.NCF file on each server in the 
cluster if it does not already exist.

Load VRDEV.NLM

This command must be placed after any HAM driver load statements. 
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NetWare Cluster Services Configuration and Setup

After configuring NSS mirroring, install NetWare Cluster Services and 
cluster-enable the NSS mirrored volume by following the instructions in 
Installation and Setup.

Edit Mirrored NSS Volume Load and Unload Scripts

When you cluster-enable a shared disk volume, certain commands are 
automatically added to the volume load and unload scripts. For mirrored NSS 
volumes, an additional command is required for both the volume load and 
unload script.

To edit the NSS mirrored volume load and unload scripts:

� In ConsoleOneTM, right-click the mirrored NSS volume object and select 
Properties.

� Click the Load Script tab on the property page and add the following line 
at the beginning of the load script.

vrdev /ASSIGN OWNER=nss_mirrored_partition

Replace nss_mirrored_partition with the name of the mirrored NSS 
partition you created in Step 2 on page 67.

The volume load script should now appear similar to the following 
example:

vrdev /ASSIGN OWNER=nssmirror

nss /activate=nssmirror

trustmig nssmirror watch

nudp add cluster1_nssmirror_server 123.45.67.120

add secondary ipaddress 123.45.67.121

� Click the Unload Script tab on the property page and add the following 
line to the end of the unload script..

vrdev /RELEASE OWNER=nss_mirrored_partition

Replace nss_mirrored_partition with the name of the mirrored NSS 
partition.
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The volume unload script should now appear similar to the following 
example.

del secondary ipaddress 123.45.67.121

nudp del cluster1_nssmirror_server 123.45.67.120

trustmig nssmirror unwatch

dismount nssmirror /force

nss /forcedeactivate=nssmirror

vrdev /RELEASE OWNER=nssmirror

Check NSS Volume Mirror Status

Once you have configured NSS mirroring with NetWare Cluster Services, you 
should check to ensure that it is working properly in a cluster environment.

� Ensure that the volume is mounted on an assigned server by typing 
volume at the server console.

� Check the mirror status of the volume by typing mirror status at the 
server console.

Mirror status should be 100 percent.

� Migrate the volume to another server in the cluster and again check to 
ensure the volume is mounted by typing volume at the server console.

� Check the mirror status of the volume again by typing mirror status 
at the server console.

Additional NetWare Cluster Services Configuration Information

For additional information on setting up and configuring NetWare Cluster 
Services, go to NetWare Cluster Services.
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Configuring DHCP with NetWare 
Cluster Services

Benefits of Configuring DHCP for High Availability

A NetWare® 5 DHCP server automatically assigns IP addresses and other 
configuration information to clients upon request or when the clients are 
restarted. If for some reason the NetWare 5 DHCP server is not accessible, 
clients lose their ability to connect to the network because they cannot obtain 
an IP address. Configuring DHCP with NetWare Cluster ServicesTM ensures 
the IP address range required by users to connect to the network are highly 
available. This is possible because DHCP configuration information and IP 
address ranges are stored in NDS®, and the DHCP server is automatically 
started, stopped, and restarted on different servers in the cluster by NetWare 
Cluster Services.

DHCP Installation and Configuration

NetWare Cluster Services (NCS) 1.01 must be installed before configuring 
DHCP. NCS 1.01 provides a DHCP resource template, which facilitates 
configuring DHCP in a cluster environment. The DHCP resource template is 
not available with NCS 1.0 and is not installed during the upgrade from NCS 
1.0 to NCS 1.01. The DHCP resource template is included only in a new 
installation of NCS 1.01.

Before running DHCP with NetWare Cluster Services, DHCP must be 
configured properly on one server in the cluster. To see DHCP documentation 
for instructions on installing and configuring DHCP with NetWare 5.1, go to 
(http://www.novell.com/documentation/lg/nds73/docui/index.html). 
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DHCP server software is included and installed automatically when you 
install NetWare 5.1, so you only need to configure DHCP after your NetWare 
5.1 server is installed. And, as stated earlier, configure DHCP on only one 
server in the cluster.

Since all DHCP configuration information and IP address ranges are stored in 
NDS, no shared storage is required to run DHCP with NetWare Cluster 
Services.

Any server in the cluster that will run DHCP must have at least a Read/Write 
NDS replica. This allows NetWare Cluster Services to modify DHCP-specific 
NDS objects regardless of which server in the cluster holds the objects.

NetWare Cluster Services Configuration and Setup

Once DHCP is properly configured on one server in your cluster, you must 
create and configure a DHCP resource in NetWare Cluster Services. This 
includes configuring DHCP load and unload scripts, setting DHCP Failover 
and Failback modes, and assigning the DHCP resource to specific servers in 
your cluster.

Creating a DHCP Cluster Resource

NetWare Cluster Services includes a DHCP resource template, which greatly 
simplifies the process for creating a DHCP cluster resource. Much of the 
DHCP cluster resource configuration is perfomed automatically by the DHCP 
resource template.

To create a cluster resource:

� In ConsoleOne, browse and select the Cluster object.

� Click File > New > Cluster > Cluster Resource.

� Enter a name for the DHCP cluster resource.

� Enter the DHCP template name in the Inherit from Template field, or 
browse and select it from the list.

� Click Create.

The DHCP resource template configures the DHCP resource by 
automatically creating DHCP load and unload scripts, setting failover and 
failback modes, and assigning DHCP as a resource to all nodes in the 
cluster. 
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After creating a DHCP resource, view and edit the DHCP resource to ensure 
it is configured correctly.

Edit DHCP Load and Unload Scripts

The DHCP resource template automatically creates a load and unload script to 
start and stop the DHCP service on servers in your cluster. The load script 
contains a command that you must customize for your specific DHCP 
configuration.

To edit the DHCP load script:

� In ConsoleOne, right-click the DHCP Resource object and then click 
Properties.

� Click the Load Script tab on the property page.

The load script will appear similar to the following example:

CLUSTER_START DHCP CN=SERVER.O=ORG.T=TREE

DHCPSRVR

The CLUSTER_START command is necessary to pass DHCP-specific 
configuration information to another server in the cluster if the server 
where DHCP is running fails.

The DHCPSRVR command is used to start the DHCP server 
(DHCPSRVR.NLM) on a NetWare server.

� Edit the CLUSTER_START command to add the context of the Server 
object for the server in your cluster that has DHCP configured.

For example, if the server context is 
CN=PROD1.O=SALES.T=ACME_TREE, the load script would appear 
as follows: 

CLUSTER_START DHCP CN=PROD1.O=SALES.T=ACME_TREE

DHCPSRVR

The server context specified in the load script does not change even 
though during failover the load script will run on another server in the 
cluster.

� Click the Unload Script tab on the property page to view the unload script. 

The UNLOAD DHCPSRVR command is by default the only command 
in the unload script.
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Setting DHCP Start, Failover, and Failback Modes

The DHCP resource template sets the DHCP resource Start Mode and 
Failover Mode to AUTO, and the Failback Mode to DISABLE. 

If the DHCP resource Start Mode is set to AUTO, the DHCP server 
automatically loads on a designated server when the cluster is first brought up. 
If the DHCP Start Mode is set to MANUAL, you can manually start DHCP on 
a specific server when you want, instead of having it automatically start when 
servers in the cluster are brought up. 

If the DHCP Failover Mode is set to AUTO, the DHCP server automatically 
moves to the next server in the Assigned Nodes list in the event of a hardware 
or software failure. If the DHCP Failover Mode is set to Manual, you can 
intervene after a failure occurs and before the DHCP server is started on 
another node.

If the DHCP Failback Mode is set to DISABLE, the DHCP server will 
continue running on the node it has failed to. If the DHCP Failback Mode is 
set to AUTO, the DHCP server automatically moves back to its preferred node 
when the preferred node is brought back online. Set the DHCP Failback Mode 
to MANUAL to prevent the DHCP server from moving back to its preferred 
node when that node is brought back online, until you are ready to allow it to 
happen.

To view or change DHCP Start, Failover, and Failback modes:

� In ConsoleOne, right click the DHCP Resource object and select 
Properties.

� Click the Policies tab on the property page.

� View or change the Start, Failover or Failback modes for DHCP.

View or Edit DHCP Resource Server Assignments

The DHCP resource template automatically assigns the DHCP resource to all 
nodes in the cluster. The order of assignment is the order the nodes appear in 
the resource list. To view or edit DHCP resource node assignments or change 
the server failover order:

� In ConsoleOne, right click the DHCP Resource object and select 
Properties

� Click the Nodes tab on the property page.
�
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� View the current DHCP resource server assignments, and if necessary, 
click the right or left arrow button to assign or unassign servers to the 
DHCP resource.

You can click the up or down arrow button to change the failover order 
of the servers assigned to DHCP.

Additional NetWare Cluster Services Configuration Information

If you have DHCP clients that are located on a separate LAN segment or IP 
subnet from the servers in your cluster, some additional configuration is 
necessary. This additional configuration consists of adding and deleting a 
secondary IP address on the cluster server where DHCP is running, and setting 
up your router to forward DHCP requests.

To add a secondary IP address:

� Edit the DHCP cluster resource load script and add the following line:

ADD SECONDARY IP ADDRESS A.B.C.D

Replace A.B.C.D with a unique IP address. Your router will forward 
DHCP requests from other LAN segments to this address.

� Edit the DHCP cluster resource unload script and add the following line:

DEL SECONDARY IP ADDRESS A.B.C.D

Replace A.B.C.D with the same IP address you added in the load script.

To configure a router to forward DHCP requests, see your router 
documentation. If you are using a NetWare server as a router, ensure the 
following line is added to the AUTOEXEC.NCF file of the server acting as a 
router.

BOOTPFWD SERVER=A.B.C.D

Replace A.B.C.D with the secondary IP address you specified in the load and 
unload scripts above.

For additional information on setting up and configuring NetWare Cluster 
Services, go to NetWare Cluster Services.
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